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1 INTRODUCTION  

OZone is a user-friendly software developed to calculate the thermal actions generated by a fire and the evolution of 
temperature in a steel structural element, using nominal fire curves or natural fire models based on physical and 
chemical parameters. OZone deals with two types of natural fire models: localised fires and compartment fires. It 
also allows the possibility to compute the fire resistance using the simple model. 

For compartment fires, OZone enables the use of One-zone or Two-zone fire models as defined in Annex D of 
EN1991-1-2. Zone models are numerical tools used to evaluate the evolution of the gas temperature within a 
compartment during a fire. Based on a limited number of assumptions, they are easy to use and provide a good 
assessment of the evolution of the temperature in the compartment. Since the first numerical One-zone models 
developed by Petersson [SPFE, 1995], major improvements of the numerical fire model have been achieved. Among 
them, multi-zones, multi-compartment and computational fluid dynamics models have been developed. Although 
zone models are less sophisticated, they have their own field of application and thus are an essential tool in fire safety 
engineering applications. 

The main assumption in zone models is that the compartments are divided into zones in which the temperature 
distribution is uniform at any time. In One-zone models, the temperature is considered as uniform within the whole 
compartment. This type of model is thus valid in case of fully developed fires. Two-zone models are more appropriate 
when the fire remains confined. In this case, the Two-zone model better represents the distribution of temperature in 
the compartment:  a hot layer close to the ceiling and a cold layer below. 

Zone models implemented in OZone have been developed in the scope of the ECCS researches “Natural Fire Safety 
Concept” and "Natural Fire Safety Concept - Full Scale Tests, Implementation in the Eurocodes and Development 
of a User-Friendly design tool. The probabilistic approach developed in the scope of “Natural Fire Safety Concept” 
has been included in EN 1991-1-2.  

OZone includes both Two-zone and One-zone models with a possible switch between them if some criteria are met. 
Several combustion models have also been developed to cover different situations. 

In large compartments where the flashover does not occur, the behaviour of the structure must be analysed under 
localised fire conditions. The localised fire procedure implemented into OZone is based on the work made in the 
research project RFSR-CT-2012-00023 LOCAFI - Temperature assessment of a vertical steel member subjected to 
localised fire. In the procedure, the configurations where the thermal exchanges are drawn by convective fluxes 
(member engulfed into the fire or situated inside the fire plume at ceiling level) are treated by application of the 
existing equations available in the EN 1991-1-2. For vertical members situated outside the fire, radiative heat 
exchanges are calculated by representing the fire as a virtual solid flame that radiates in all the directions. OZone 
considers a conical shape for this virtual solid flame. The flux is calculated separately for the 4 faces of the box 
perimeter of the profile and an average value of this flux is applied to the whole box perimeter of the steel section. 
This means that the shadow effect is implicitly taken into account.  

In OZone is possible to define a localised fire inside a compartment. In this case, for the thermal analysis, the user 
can obtain the temperature in the steel profile from the compartment hot zone, from localised fire, or the maximum 
between both.  

The software has been validated against numerous results of tests and CFD analyses. 
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2  MENU BAR 

The menu bar has the following menus: “File”, “Tools”, “View” and “Help” (see Fig. 1).  

 

Fig. 1 Main window – Menu bar 

• To save the current analysis in a file, select the “Save analysis” command, from the “File” menu. 
To save the current loaded analysis, saved previously in a file, select the “Save Analysis As…” command, 
from the File Menu. 
Both commands will open the “Save As” common dialog window, in which the user can select the folder 
and type in the File Name of the file. The analysis file will be saved with the *.ozn extension, and OZone 
will associate itself with these files (i.e. by double clicking on the file name in Windows explorer, or selecting 
the Open command from the context menu, the operating system will launch OZone and open the file). 
To start a new analysis, select the “New Analysis” command from the “File” menu. 
The “Page Setup” command from the “File” menu will open the common dialog page setup window in which 
the user can select the paper size, orientation and fill out the margins of the printed chart. 

• In the “Tools” menu, the user can add or change the materials and their thermal properties for the enclosure, 
by selecting the “Add Wall Material” command. 
To add or change the steel fire protection materials, select the “Add Steel Insulating Materials” command.  
It is not possible to change a wall material or steel insulating material unless there is no change in any of the 
windows. If OZone warns: “There is a loaded file….”, select the “New Analysis” command from the “File” 
menu, and change the values in any of the two windows. The changes to the wall materials or steel insulating 
materials will take place when restarting OZone. 
The last command in the Tools menu is the Language command. At this moment only two languages are 
available: English and French. 
To change the user interface language in OZone, select the “Language” command from the “Tools” menu, 
and in the opened dialog box, select the desired language from the dropdown list “Select Language”.  

• The “View” menu contains the commands for displaying either the analysis data (RHR Data, Pyrolysis Rate 
Data), or results (RHR Computed, Pyrolysis Rate Computed, Hot Zone Temperature, etc) in charts. Not all 
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the commands from the View menu are enabled, depending on the status of the analysis. For example, if the 
steel temperature is computed, the “Steel Temperature” command is enabled. 
The last command in the “View” menu will create a report of the current analysis. The report will be saved 
as a Microsoft Word document, in the same folder as the analysis file name, under the name of the analysis 
file name. The chart data can be exported to Excel using the context menu. Right click anywhere in the chart 
and from the context menu select the “Copy Chart” command. Switch to Excel and select Paste (see Fig. 2). 

 

Fig. 2 Chart window 

Depending on the plotted data in the chart window, the user can show up to three series in the chart, by selecting the 
name of the series from the context menu (right mouse button) in the chart window (see Fig. 3). 
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Fig. 3 Chart window 

The folder where the analysis file is saved will contain the following files, besides the analysis file (with the *.ozn 
extension):  

• Filename.pri - is the data output file, containing the hot zone temperature, cold zone temperature, etc); 

• Filename.out - is the output file, containg data about the lining of the compartment as well as the criteria 

of switching from the two zone model to the one zone model; 

• Filename.nat - is the output file that contains the gas temperature when either localised fire or the 

maximum between both is selected in the “Heating” window; 

•  Filename.flx - is the output file that contains the net heat flux evolution for the localised fires; 

•  Filename.stt - is the output file that contains the steel temperature evolution, either protected or 

unprotected. 

Not all these files will be present in the folder where the analysis file is saved, depending on the type of fire 
(compartment or localised) and heating scenario. 
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3 MAIN WINDOW  

OZone allows the user either to apply the prescriptive approach (nominal fires) to generate thermal actions or 
performance-based approaches, in which the thermal actions are determined using the Zone Model approach. 

The main window is structured in two columns (see Fig. 4). 

 

Fig. 4 Main window 

The “ Natural Fire” column refers to the thermal actions assessed by either zone fire models for compartment or 
localised fires.  

In case of a compartment fire, the user must first define the geometry of the compartment, the composition of walls, 
ceiling and floor, as well as the dimension and position of the openings, within the “Compartment” window, 
explained in Chapter 4. In the “Fire” window, explained in Chapter 5, the user further defines the fire, based on 
Annex E/ EN 1991-1-2 procedure or by direct input (user defined). 

In case of localised fire, the user may skip the “Compartment” window. The fire can be defined directly within the 
“Fire” window, in order to represent a localised fire in an open space. The localised fire may also be considered 
inside a compartment. In this case, the enclosure must be defined within the “Compartment” window.  

The analysis is performed by selecting the “Thermal Action” button. 

The “Thermal Analysis” column of the general window allows to calculate the evolution of the temperature in a steel 
profile, based on the thermal action calculated by means of a natural fire (first column), or based on nominal fire 
curves. The selection of the thermal action (nominal fire curve, compartment fire, localised fire) is done in the 
“Heating” window. 
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In case of a thermal action previously determined using natural fire models, the steel profile may be heated 
considering in the “Heating” window either the hot zone temperature (from a compartment fire) or the localised fire 
temperature.  

If the characteristics of the enclosure are defined within the “Compartment” window, and a localised fire is defined 
in the “Fire” window, the user may also consider for the heating of the steel profile the maximum heat flux between 
the hot zone (compartment fire) and the localised fire. In this case, there is no need to define a compartment fire 
(Annex E – EN 1991-1-2/ User defined fire) within the “Fire” window.   

In case of a nominal fire curve, there is no need to pass through the first column “Natural Fire” of the general window. 
The user directly selects the nominal curve in the “Heating” window. 

The protected/ unprotected steel profile is defined in the “Steel profile” window. The analysis is performed by 
selecting the “Steel Temperature” button. 

The “Strategy” and “Parameters” windows are explained in Chapters 6 and 7. 
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4 COMPARTMENT WINDOW  

When a compartment fire is modelled in OZone, the first step is to select the compartment shape (see Fig. 3): either 
a rectangular floor (with Flat Roof, Single Pitch Roof or Double Pitch Roof), or a non-rectangular floor (Any 
Compartment) with a flat roof.  

For rectangular floor compartments the dimensions i.e. Length, Height and Depth must be inputted, in meters.  For 
non-rectangular floor compartments, the maximum number of walls is four, and the surface area of the compartment 
must be provided, in m2.  

 

Fig. 5 Compartment window 

To define a compartment lining (Floor/ Ceiling/ Wall), select the corresponding item from the “Select Wall” 
dropdown list and click the “Define” button. This will open the compartment lining definition window, (see Fig. 5). 

For each compartment lining (walls, ceiling and floor), up to four layers may be defined across the thickness. If 
multiple layers are considered, they must be defined from inside to outside, starting with Layer 1 (inside). For 
predefined materials from the dropdown list, only the thickness of the layer must be introduced.  The user may define 
any material by introducing all its characteristics in the table (Unit Mass, Conductivity, Specific Heat, Relative 
Emissivity on the Hot and Cold Surfaces) (see Fig. 6). 
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Fig. 6 Compartment lining definition window 

 

Fig. 7 Definition of the vertical openings 
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Horizontal and/or vertical openings may be defined within ceiling and walls, inside the compartment lining definition 
window.  

For a wall, up to three openings may be defined. The Sill Height, Soffit Height and Width must be input for each 
opening, in meters (see Fig. 7). By default, a constant opening is proposed, but a variation of the opening may be 
selected from the “Variation” dropdown list. The options (Temperature Dependent/ Stepwise/ Linear/ Time 
Dependent) are explained in Chapter 7 “Parameters”. For the “Adiabatic” option and detailed explanation about the 
heat exchanges through openings, see Annex A. 

When the ceiling is defined, horizontal openings may be defined in the lower table, see Fig. 8. Up to three equal 
diameter groups may be defined. The diameter in meters and the number of openings of each group shall be provided. 
By default, a constant opening is proposed, but a variation of the opening may be selected from the Variation 
dropdown list. The options (Temperature Dependent/ Stepwise/ Linear/ Time Dependent) are explained in Chapter 
7 “Parameters”. 

 

Fig. 8 Definition of the horizontal openings 

Forced ventilation may also be defined in the lower table of the Compartment definition window (see Fig. 5). Up to 
three devices can be entered, by defining the Diameter and Height in meters above the floor level, Volume of intake 
(In) or exhaust (Out) air in m3/sec. For an explanation about the smoke extractors see Annex B. 
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5 FIRE WINDOW  

The “Fire” window allows the definition of a compartment fire (using Annex E of EN 1991-1-2 and the corresponding 
National Annexes or a User defined Fire) or a Localised Fire, see Fig. 9. 

 

Fig. 9 Fire window 

5.1 Compartment Fire – Annex E (EN1991-1-2)  

By default, the EN 1991-1-2 Annex E values are proposed, but the user may select a National Annex from the 
dropdown list “National Annexes” or user-defined values. Annex C presents the national parameters for the 
application of the Natural Fire in the different European countries, for which the National Annexes are available in 
OZone. 

Within this window, according to Annex E of EN 1991-1-2 (Default), the design fire load density is given by:   

kfniqqdf qmq ,21, ⋅Π⋅⋅⋅= δδδ   

Firstly, the parameters related to the Occupancy should be introduced (Fire Growth Rate/ Maximum Rate of Heat 
Release/ Characteristic Fire Load Density/ Danger of Fire Activation). OZone contains tabulated values for these 
parameters, according to Annex E of EN 1991-1-2, which may be chosen from the “Occupancy” dropdown list. If 
other values are needed, the user may select the “User Defined” in the same dropdown list.  

The characteristic fire load density qfk is the 80% fractile of the fire load distribution obtained by survey in real 
compartments. Data are available for different types of occupancies of compartments. In order to obtain the 
characteristic fire load density, the mass of combustible present in compartments has been measured and then 
multiplied by the combustion heat of the fuel and divided by the floor area of the compartment. The complete 
combustion heat has been considered in these evaluations. 
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The growing phase of the fire is characterised by the Fire Growth Rate ta, representing the time at which the fire 
area Af has grown to a value leading to a rate of heat release of 1MW.  

The Maximum Rate of Heat Release per Unit Area of Fire (RHRf) is the maximum quantity of energy which can be 
released by unit area of fire in a steady state and fuel-controlled situation. RHRf is given in Annex E of EN1991-1-2 
for different types of compartment occupancies. The values of RHRf represent real fires and take into account the 
incomplete combustion.  

The Fire Growth Rate, the Maximum Rate of Heat Release per unit area of fire and the Characteristic Fire Load 
Density are given in Annex E of EN1991-1-2 function of the Occupancy.  

The influence of the danger of fire activation is taken into account by the2qδ  factors given in Annex E EN1991-1-

2. 

The influence of active measure is taken into account by the in,δ  factors given in Annex E EN1991-1-2. The user 

shall check/ uncheck the options within the Active Fire Fighting Measures group, function of their availability.  

The influence of the compartment area is taken into account by the 1qδ  factor, automatically calculated function of 

the area of the compartment. The values of 1qδ  are approximated by equation (1). This law has been obtained by a 

fit on tabulated values from table E1 of EN 1991-1-2.  

  ( ) 5752.0ln1688.01 +⋅= fq Aδ  (1) 

The maximum fire area Afi,max is the maximum burning area of fuel, i.e. the maximum area of floor on which 
combustible is present. In most cases, the maximum fire area may be considered as equal to the floor area. By 
default, OZone considers this value, computed from the data provided in the Compartment window. The user may 
consider different values for the maximum fire area, which may be lower than the area of the compartment. 

Fire elevation is considered by default at the floor level. The user may enter another elevation for the source of the 
fire (see Fig. 10). This may affect the Flash-over criteria, explained in Annex F.  

Fuel Height is considered by default at the floor level. The user may define another maximum height of the 
combustible material within the compartment (see Fig. 10).  This may affect the Flash-over criteria, explained in 
Annex F. 
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Fig. 10 Fire elevation and Fuel height 

The combustion efficiency factor is considered with the default value given in EN 1991-1-2, i.e. m = 0.8. The user 
may enter another value, function of the occupancy and of the type of fire load. 

Users of OZone have to choose between the three different combustion models. With "No combustion model", the 
presence of oxygen in the compartment does not influence the rate of heat release. When no more oxygen is available 
inside the compartment, the "External flaming" combustion model limits the amount of energy release inside the 
compartment and the "Extended fire duration" combustion model limit the amount energy release inside the 
compartment and extend the initial fire duration. More details are given in Annex B. 

The Stoichiometric Coefficient is considered in the OZone algorithm as 1.27. The user may define another coefficient 
within the “User Defined Fire” option. 

5.2 Compartment Fire - User Defined Fire 

It is possible to define any compartment fire curve by using the “User Defined Fire” option within the “Fire” window.  
As shown in Fig. 11, the table on the left has four columns, Time (in seconds) RHR (rate of heat release in MW), 
mf (the pyrolysis rate in kg/s) and Fire Area in m2.  
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Fig. 11 User Defined fire window 

Within the “Fire Info” group the Maximum Fire area (in m2), the Fire Elevation (in m) and the Fuel Height (in m) 
may be introduced (see Fig. 9). The significance of the parameters within the “Combustion” group is also the same 
as defined within the previous paragraph (see Fig. 9). 

The “User Defined Fire Columns” group will lock or unlock some of the columns of the table. If “Only RHR” is 
selected (default), only the first two columns (Time and RHR) are editable.  

If “Only mf” is selected, the Time and mf columns are editable. If “RHR and mf” is selected, both RHR and mf 
columns are editable alongside the time column. 

The relationship between the parameters is: 

 ������ = � ∙ �	,��
 ∙ �� ����� (2) 

where:  

m is the Combustion Efficiency Factor 

�	,��
 is the Combustion Heat of Fuel  

If the fire area is known at each time step, the user can check the “Fire Area” checkbox and the Fire Area column in 
the left table becomes editable. Thus, the values of the fire area about time can be entered in the table. 

If the fire area about time is not known, Ozone will compute ������ according to: 

 ������ = ���,��� ∙
����
�

������
 (3) 
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where: 

Afi,max is the maximum fire area defined within the “Fire Info” group. 

Four scenarios are possible. 

Case 1. RHR, mf and Fire Area are given by the user within the table 

When the complete range of data is available, the user can enter all four columns. This case corresponds to tests 
where the mass lost and the rate of heat release inside the compartment have been measured. The fire area is also 
known at each time. For example, this situation could happen when modelling a full-scale pool fire test with two 
zones with mass loss measurement and RHR measurement by oxygen depletion in the upper layer gases extraction 
device. In this situation, it is not possible to use any combustion model.  

Case 2. RHR and mf are given by the user within the table 

This case corresponds to tests where the mass lost and the rate of heat release inside the compartment have been 
measured. The fire area is not known and is assumed to be proportional to the heat release rate. In this situation, it 
is not possible to use any combustion model.  

Case 3. RHR or mf and also Fire Area are given by the user within the table 

This case corresponds to tests where the mass lost or the rate of heat release inside the compartment have been 
measured. The unknown quantity is deduced based on the Eq. (2) and Eq. (3). The fire area is known at each time. 
In this situation, it is not possible to use any combustion model. 

Case 4. RHR or mf are given by the user within the table 

This case corresponds to tests where the mass lost or the rate of heat release inside the compartment have been 
measured. The fire area is not known and is assumed to be proportional to the heat release rate. The unknown 
quantities are computed based on Eq. (2) and Eq. (3). The combustion models can be used or not.   

The user can import or export the data from the table. For importing the data, a txt file must be filled in with the data 
in two, three or four columns in the same order as in the table. The first column must contain the time in seconds. 
At least two columns must be defined (eg. time and RHR). The separator for the data must be space not tabs or 
comma.  

5.3 Localised fire 

Up to five localised fires can be defined, see Fig. 12. The upper table on the left will contain their diameters (in m) 
and position on the floor by means of x and y coordinates (in m). 
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Fig. 12 Localised fire window 

The group “Geometrical Data” defines the Ceiling Height (in m) and the point where the localised temperature is 
calculated, by means of the Distance on the x axis (in m) and of the elevation from the floor - Height on the z axis 
(in m). By definition, the y-axis coordinate of the column is 0. 

The localised fire can be defined directly within this window, without defining the compartment, within the 
“Compartment” window. If a compartment was already defined within the “Compartment” window, the Ceiling 
height will be automatically taken as the previously defined Height of the compartment. 

The table on the right will contain the RHR about time in MW. The user will select the fire number from the 
dropdown list at the top of the table and fill out the values in the table. Data from other tabulated sources (like Excel) 
can be used to paste the values into the table by using the paste shortcut key (Ctrl+V). 

Details about the procedure for calculating temperatures from localised fires are given in Annex D. 
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6 STRATEGY WINDOW  

The “Strategy” window shown in Fig. 13 is related to compartment fires only. 

 

Fig. 13 Strategy for compartment fires 

Two-zone and One-zone models are based on different hypotheses. Indeed, they correspond to different types of fire 
or different stages of the same fire. They simply have different application domains and, in fact, they are 
complementary. When modelling a fire in a given compartment, it is important to know whether a Two-zone model 
or a One-zone model is appropriate.  

The fire load can be considered as uniformly distributed if the real combustible material is present more or less on 
the whole floor surface of the fire compartment and when the real fire load density (quantity of fuel per floor area) 
is more or less uniform. By opposition, the combustible material can be concentrated on a quite small surface area 
compared to the total floor area, the rest of the floor area being free of fuel.  

Fires ignitions are in most cases localised and therefore a fire remains confined within a certain area for a period. If 
temperatures are sufficiently high to provoke spontaneous ignition of all the combustible present in the compartment, 
a flashover occurs. Generally, Two-zone models are valid when the fire remains localised or for pre-flashover fires, 
while One-zone models are valid in case of fully engulfed fires or post-flashover fires. Similarly, the Two-zone 
assumption is not appropriate anymore when the height of the cold zone is too small. Finally, if the fire area is large 
compared to the floor area, the One-zone model assumption is more realistic than the Two-zone one.   

An automatic combination strategy is implemented in OZone. With this strategy, the simulation always begins with 
the Two-zone model assumption and, if one of the criteria for flash-over is satisfied (see Annex F), the simulation 
will switch to One-zone model.  

Within ‘Select Analysis Strategy’ group, the user can impose the use of One-zone or Two-zone model, or let the 
default strategy combination of the two models.  
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Within “Transition (2 Zones to 1 Zone) Criteria” group, the user may change the values of the four parameters that 
control the switching from the Two-zone model to One-zone model. It is strongly recommended to keep these values 
unchanged, unless relevant data is available.  The criteria of the transition from Two- to One-zone and the 
consequences on the fire source model are discussed in Annex F.  The modifications of the main variables and of 
the basic equations when the one zone model switch occurs are presented in detail in the same Annex F.  
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7 PARAMETERS WINDOW  

Most of the parameters used in the calculations are given within this window, see Fig. 14. 

 

Fig. 14 Parameters window 

7.1 General parameters 

On the left side of the window, the following parameters are given with default values: 

• Radiation through closed openings: default expert value from literature is 0.8  

• Bernoulli coefficient: default expert value is 0.7 

• Physical characteristic of the compartment: assuming normal initial temperature of 20oC and air pressure 

of 100000 Pa 

• Parameters of wall material: the convection coefficients for hot/ cold surfaces according to EN1991-1-2; 

these parameters refer only to natural fire models, for the nominal fires defined in the ‘Heating’ window, 

the corresponding values given by EN1991-1-2 are implemented 

• Calculation parameters: by default, the analysis time is considered two hours; it is recommended to keep 

the maximum time step for calculation at 10 seconds 

• Fire design partial safety factor: considered with the default value of EN1991-1-2 
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7.2 Air entrained model 

When a mass of hot gases is surrounded by colder gases, the hotter and less dense, mass will rise upward due to the 
density difference or, depending on gas velocity, due to buoyancy. This phenomenon happens above a burning fuel 
source. The buoyant flow is referred to as a fire plume. Cold air is entrained by the rising hot gases, causing a layer 
of hot gases to be formed below the ceiling. Different analytical expressions of the properties of fire plume have 
been proposed by several authors. Four of them have been implemented into OZone.   

It should be mentioned that some of these empirical formulas have been obtained by fit on the total energy release 
rate Q and others on the convective part of it Qc. In OZone, it is assumed that Qc is equal to 0.7 Q.  

7.2.1 Heskestad  

The model of Heskestad is the model with the less assumptions which best fit to CFD plume, and therefore is 
considered as the default option in Ozone. 

The virtual origin of the plume is at the altitude z0 : 

 DQz ⋅−⋅= 02.1083.0 52
0

&   (4) 

The flame height Lfl is given by:  

 DQL fl ⋅−⋅= 02.1235.0 52&   (5) 

The plume mass flow rate above the flame height (z > Lfl,) is given by:  

 ( ) ccp QzzQm && ⋅+−⋅= 92.1071.0 35
0

31   (6) 

The plume mass flow rate below or at the flame height (z < Lfl,) is given by:  

 
fl

cp L

z
Qm &⋅= 0056.1  (7) 

7.2.2 Zukoski  

 3531
2

21.0 zQ
Tc

g
m

p
p 













=

∞

∞ρ
 (8) 

7.2.3 Mac Caffrey   
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7.2.4 Thomas  

The Thomas plume model is intended for entrainment in the near field or flame region, when the mean flame height 
is considerably smaller than the fire diameter. In this region, the entrained air is less influenced by the heat release 
rate then by the fire perimeter, and therefore the fire diameter.  

 2359.0 Dzmp =   (12) 

7.3 Temperature and Time Dependent Openings 

During a fire, the number of openings and their size can vary. This can be the result of glazing breakage, automatic 
opening or firemen arrival.  In OZone, the opening size can be defined as a function of temperature of the zone in 
contact with the glass (TZ) or to be a function of time.  

Criteria function of zone temperature can represent breakage due to thermal action. Criteria function of time can 
represent the firemen arrival. Four variation types exist: a one-step variation with temperature, a stepwise variation 
with zone temperature, a linear variation with zone temperature and a variation with time (see Fig. 15).  A broken 
glazing cannot be closed afterward. So, the percentage of broken glass is either increasing, either constant, but never 
decreasing.  

 
 

a) Temperature dependent b) Temperature dependent - Stepwise 

variation 

  

c) Temperature dependent - Linear variation   d) Time dependent 

Fig. 15 Temperature and time dependent openings 
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The EN 1991-1-2 does not mention any recommendations for the openings, although the influence in the results may 
be significant. ITM SST – 1551.1 (from Luxembourg authorities) is the unique document at the knowledge of the 
developers that have made recommendations without any specific information. The developers recommend using the 
above presented scenarios. 
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8 THERMAL ACTION BUTTON  

After the definition of the Compartment and Fire, the analysis is performed by clicking the “Thermal Action” button. 
The results can be extracted from the “View” menu, see Fig. 16. A full report of the results is obtained by selecting 
the “Report” command, which creates a *.doc file in the same folder as the analysis file (saved with the *.ozn 
extension). 

 

Fig. 16 General window after clicking the “Thermal Action” button 

All charts contained in the Report file can be independently opened in the “View” menu. From these windows, the 
data can be imported in other programs (Excel, Word, PowerPoint, etc.), by selecting the “Copy Chart” command 
from the context menu, which appears by clicking the right mouse button (see Fig. 2).  
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9 HEATING WINDOW  

In the “Heating” window (see Fig. 17), the user can select the thermal action used for heating the cross-section 
defined in the “Steel Profile” window. Either natural fires or nominal fires can be used. 

If a nominal fire curve (ISO 853/ ASTM E119/ Hydrocarbon) is considered for the profile heating, the definition of 
the compartment and of the fire within the “Natural Fire” column in the general window are not needed. 

 

Fig. 17 Heating window 

For natural fire models, several scenarios can be used. 

For compartment fires, it is necessary to define both the compartment and the fire characteristics. When “Annex E” 
or “Used defined Fire” is selected in the “Fire” window, only the “Hot Zone Temperature” option is active in the 
“Heating” window. 

For localised fires, if no compartment is defined, it is assumed that the localised fire develops in open space and only 
the “Localised Fire Temperature” option is active. 

If a compartment is defined together with a localised fire, OZone calculates the hot/ cold zones temperatures in the 
compartment (depending on the selected strategy), considering automatically the “Maximum Fire Area” within the 
“Fire” window as the sum of the localised fires defined in the “Localised Fire” window. In this case, the user may 
select one of the three options (Hot Zone Temperature/ Localised Fire Temperature/ Maximum Between Both). 

The Maximum Between Both option determines the maximal temperature based on the following algorithm (see Fig. 
18): 
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- if the point where the temperature is computed (Height on Axis (z) in the interface) is in the upper layer 
defined as the difference between the compartment height and the interface height (Zs) then the maximum 
temperature between the hot zone compartment fire and localised fire is applied on the steel profile; 

- if the point is below this layer the localised fire temperature is applied to the steel profile. 

 

Fig. 18 Algorithm for maximum between both explained 
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10 STEEL PROFILE WINDOW  

After the definition of the Heating scenario, the Steel Profile button allows for the definition of the profile type and 
exposure. Both protected and unprotected steel cross-sections can be considered, exposed on four or three sides. If a 
localised fire is defined, only the Unprotected Cross section option is active. 

Both contour and hollow encasement protections can be defined, considering both constant and temperature 
dependent thermal properties (introduced by the user). For predefined protection materials, only constant values are 
given.   

 

Fig. 19 Steel profile window 
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11  STEEL TEMPERATURE BUTTON  

The heating of unprotected or protected steel profile is then calculated by considering the EN 1993-1-2 methods. The 
gas temperature is either the upper zone temperature, the localised fire temperature or the maximum of these two 
temperatures. 

The evolution of steel temperature is computed using EN1993-1-2 equations for protected/ unprotected steel cross-
sections. 

The temperature – time evolution on the cross-section is obtained by clicking on the Steel Temperature button. As 
for Zone temperature analysis, the results can be extracted from the View menu and a full report of the results is 
obtained by selecting the Report command, which creates a doc file in the same folder as the analysis file. This report 
will contain also the temperature evolution of the steel profile and its characteristics.  

The Steel temperature chart contained in the Report file can be independently opened in the View menu. From this 
window, the data can be imported to other programs (Excel, Word, PowerPoint, etc), by selecting the copy Chart 
command from the context menu (see Fig. 20). 

 

Fig. 20 The Chart window 
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ANNEX A - ZONE MODEL FORMULATION  

The Annex presents the fundamentals of the two and one zone models. Figures A1-2 show schematic views of the 
two models. 

 

 

Fig. A1 Schematic view of two zone model and associated submodels 
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Fig. A2 Schematic view of one zone model and associated submodels 

A.1 Two-zone model 

Two-zone models are normally based on eleven physical variables. These variables are linked by seven 
constraints and four differential equations describing the mass and the energy balances in each zone.  

The time integration of these differential equations allows to calculate the evolution of the variables 
describing the gas in each zone. The mass balance equation expresses the fact that, at any moment, the 
variation of the mass of the gas of a zone is equal to the mass of combustion gases created by the fire, plus 
the mass coming into the compartment through the vents minus the mass going out of the compartment 
through the vents. The energy balance equation expresses the fact that, at any moment, there is a balance 
between, on one hand, the energy which is produced in the compartment by the combustion and, on the 
other hand, the way in which this energy is consumed: by the heating of the gases in the compartment, by 
the mass loss of hot air through the openings (including a negative term accounting for the energy of 
incoming air), by the radiation loss through the openings and, finally, by the heating of the partitions. It has 
to be mentioned that the term "partition" is used here to represent all the solid surfaces of the enclosure of 
the compartment, namely the vertical walls, the floor and the ceiling. 

The eleven variables which are considered to describe the gas in the compartment are: mU and mL, the mass 
of the gas of respectively the upper and lower layer; TU and TL, the temperatures of the gas; VU and VL, the 
volumes; EU and EL, the internal energies; ρU and ρL, the gas densities of respectively the upper (U) and lower 
(L) layer and finally p, the absolute pressure in the compartment considered as a whole. 

The seven constraints are: 

 
i

i
i V

m
=ρ  
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 ( ) iiVi TmTcE =  

 ii RTp ρ=  (A.1) 

 LU VVV +=  

 LUi ,=  

with: cV(T), the specific heat of the gas in the compartment; 

R, the universal gas constant 

i, equal U for upper layer & L for lower layer 

The specific heat of the gas at constant volume and at constant pressure, the universal gas constant R and 
the ratio of specific heat are related by: 

 ( ) ( )ivip TcTcR −=   

  (A.2) 

 ( ) ( )
( )iv

ip
i Tc

Tc
T =γ  

The variation of the specific heat of the gas with the temperature is taken into account by the following 
relation: 

 ( ) ( )[ ]kgKJTTcp 952187.0 +=  (A.3) 

This law is obtained by a linear regression on the point by point law given in the NFPE Handbook of Fire 
Protection Engineering. 

The mass balance equations have the general form of equations (A.4) and (A.5) in which a doted variable 
x& means the derivative of x with respect to time. Equations (A.4) et (A.5) states that the variation of 
gaseous mass in each zones is made of the mass exchanges of one zone with the fire, with the other zone, 
and with the external world through the different vent types (see Annex B). 

 fieUFVoutUFVinUHVoutUHVinUVVoutU mmmmmmmm &&&&&&&& ++++++=  (A.4) 

 eLFVoutLFVinLHVoutLHVinLVVoutLVVinUVVinL mmmmmmmmm &&&&&&&&& −++++++=  (A.5) 

The energy balance equations have the general form of equations (A6) and (A7) stating that the variation 
of energy in each zones is made of the energy exchanges of one zone with the fire, with the other zone, 
with the surrounding partitions and with the external world trough vents. 

 ( ) RHRTmTcqqqqqqqq LentLpUFVoutUFVinUHVoutUHVinUVVoutUwallUradU 7.0++++++++= &&&&&&&&&  (A.6) 

 entLFVoutLFVinLHVoutLHVinLVVoutLVVinUVVinLwallLradL qqqqqqqqqqq &&&&&&&&&&& −++++++++=  (A.7) 



LOCAFI+ – Temperature assessment of a vertical steel member subjected to LOCAlised Fire – Dissemination      Page 38 
 

RFCS-2016“LOCAFI+”-Grant Agreement 754072   

In these balances, mass or energy rate corresponding to a decrease of mass or energy in the compartment 
are negatives. 

Four basic variables have to be chosen to describe the system. Provided that the zones temperatures TU and 
TL, the altitude of separation of zones ZS and the difference of pressure from the initial time ∆p are chosen, 
equations (A.4) to (A.7) can be transformed in the system of ordinary differential equations (ODE) formed 
by equations (A.8) to (A.11). [FORNEY 1994]: 
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A.2 One-zone model 

In case of a one zone model, the number of variables which is reduce to six, describing the gas in the 
compartment as a whole. i.e. mg, the mass of the gas; Tg, the temperature of the gas; V, the volume of the 
compartment (constant); Eg, the internal energy; p, the pressure in the compartment; ρg, the gas density. 

The number of constraints is reduced to 4: 

 
V

mg
g =ρ  

 ( ) gggVg TmTcE =  

 ggRTp ρ=  (A.12) 

 constV =  

The mass balance is expressed now by equation (A.13): 

 fiouting mmmm &&&& ++=  (A.13) 

And the energy balance is expressed by equation (A.14): 

 ( ) ( ) RHRTmTcTmTcqqq outinoutpgoutgpwallradU ++++= &&&&&  (A.14) 

In these balances, mass or energy rate corresponding to a decrease of mass or energy in the compartment 
are negatives. 
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Four basic variables have to be chosen to describe the system. Provided that the zone temperature T and the 
difference of pressure from the initial time ∆p are chosen, equations (A.13) and (A.14) can be transformed 
in the system of ordinary differential equations formed by equations (A.15) and (A.16). 
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 (A.15) 

 ( ) ( )( )pVTmTcq
VTc

T gggp
ggp

g ∆+−= &
ρ

1
 (A.16) 

A.3 Time integration 

As mentioned, the systems of equations (A.8) to (A.11) (2ZM) and of equations (A.15) and (A.16) (1ZM) 
are to be solved to know the gas characteristics of zones at each time. These systems of ODE are stiff. A 
physical, although not rigorous from a mathematical point of view, interpretation of stiffness is that the 
time constant relative to the pressure variation is much shorter than the time constant of the temperature 
variation. It is therefore usual to rely on a specialised library solver specifically written for this kind of 
problem. In the code OZone, the solver DEBDF is used. 

A.4 Partition model 

Usually the partition models of zone model are based on finite difference. This method does not allow to 
solve the equation implicitly and therefor to fully couple the zone and the partition models. This problem 
can be solved model by using the finite element method and by modifying the usual finite element 
formulation. To fully respect the energy balance in case of one zone model, partitions have to be modelled 
by one dimensional finite elements and in case of two zone model have to be modelled by two dimensional 
finite elements because vertical fluxes exist in vertical partitions. 

Even if OZone includes a two zone and a one zone, a one dimension partition model has been included. 
Some preliminary work on two zone model with a two dimensional partition model has been made and has 
shown that the partition model based on one dimension finite elements is a good approximation of the one 
based on two dimension. In most cases, the two-dimensional phenomena are negligible. The increases of 
the computing time and of the difficulties to define the compartment are quite big and are useless in most 
cases. 

Partitions can be divided in three types: the upper horizontal partition, the ceiling; the lower horizontal 
partition, the floor; and, finally, the walls. The basic finite element formulation is the same for the three 
types of partitions but the boundary conditions are different. 

A.4.1 Partition model formulation 

A partition is discretised by a single dimension finite element model as depicted in Figure A3. With this 
discretisation, the temperature is computed at the interface between the different layers, or elements, and 
the hypothesis is made of a linear temperature variation on the thickness of each layer. 
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Fig. A3 one dimensional finite elements discretisation of partitions 

With this discretisation and this hypothesis on the field of temperature, the equilibrium of each finite 
element i is described by the following equation: 

 [ ][ ] [ ][ ] [ ]ielielielieliel gTCTK ,,,,, =+  (A.17) 

with: 








=
+1,

,
,

iw

iw
iel T

T
T  (A.18) 

 








−
−

=
11

11
,

i

i
iel L

k
K  (A.19) 

 







=

5.00

05.0
, iiiiel LcC ρ  (A.20) 

and 








=








=








= −
out

nelnelel
wall

el q
ggtog

q
g

&

& 0
;

0

0
;

0 ,1,2,1,  (A.21) 

Equations A.18 and A.19 are in fact simplified expressions because the material properties have been 
considered as constant in each element, allowing to take them as constant multipliers out of the matrix. The 
temperature dependency in the element could also be taken into account, owing to the well-known 
numerical integration techniques of Gauss. Equation (A.20) is furthermore the diagonal version of the 
complete matrix, having a value of 1/3 for the diagonal terms and 1/6 for the off-diagonal terms. The 
advantage of the diagonal form is first that it smoothes the spatial oscillations which could arise in the 
solution if too thick elements are used in the discretisation. Another advantage is related to the computing 
strategy. 

The assembly of the N equations of type (A.17) which can be written for each of the N finite element 
making the partition produces the system of equations (A.22) in which the size of the vectors is N+1 and 
(N+1) x (N+1) for the matrices. 

 [ ][ ] [ ][ ] gTCTK ww =+  (A.22) 



LOCAFI+ – Temperature assessment of a vertical steel member subjected to LOCAlised Fire – Dissemination      Page 41 
 

RFCS-2016“LOCAFI+”-Grant Agreement 754072   

 



























=

out

wall

q

q

g

&

M

&

0

0

 (A.23) 

The energy transmitted at the partition interface results from heat transfer by convection and radiation 
between zones and the partition and between the fire and the partition. The energy transmitted at the 
interface between the outside world and the partition is due to heat transfer by convection and radiation.  

We note Tw1 the inside partition surface temperature and Tw,n+1 the outside partition surface temperature. Tz 

is the gas temperature of the zone in contact with the partition inside surface, i.e. Tz = TU or TL in case of 
2ZM or Tz = Tg in case of 1ZM. 

From the system of equations (A.22), it is very easy to obtain the system of equations (A.24), efficiently 
computed due to the diagonal nature of C. 

 [ ] [ ] [ ][ ]( )ww TKgCT −= −1  (A.24) 

This system of equations is a set of N differential equations for the N temperatures of the partition. The 
temperature of the compartment is only present in the first term of the load vector. It has a similar form as 
the system of equations (A.8) to (A.11) (2ZM) and of equations (A.15) and (A.16) (1ZM) established for 
the variables of the gas zones and could be written in the following way. 

 ( )2,1,11, ,, www TTTgT =& , ( )3,2,1,22, ,, wwww TTTgT =& , ( )outNwNwNNw TTTgT ,, 1,,1, ++ =&  (A.25) 

A.4.2 Connection of the zone and the partition models 

Two zone model 

In 2ZM, the ceiling is always connected to the upper layer and the floor to the fire and to the lower layer. 
Vertical partitions are divided in two parts, an upper one, connected to the upper layer and a lower one 
connected to the fire and to the lower layer (Figure A4). The area of each part is calculated by multiplying 
the length of the wall by its height which is varying with time and is function of the altitude of separation 
of the zones, ZS. The area of openings included in each partition are of course subtracted. The finite element 
discretisations of the two parts are identical, only the boundary conditions are different. 

 
Fig. A4 Two zone model 
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The system of equations (A.24) has to be built once for the ceiling and once for the floor. If the enclosure 
has M different types of walls, it has to be build 2M times. If Neq,c and Neq,f the number of node of the ceiling 
and of the floor, and Neq,i the number of node of the wall n°i, the total set of partition equations contains 
Neq,w differential equations, given by equation (A.26). 

 ∑
=

++=
M

i
ieqceqfeqweq NNNN

1
,,,, 2  (A.26) 

Equations (A.8) to (A.11) and equations (A.24) form a set of Neq,w+4 differential equations which can be 
passed on to the numerical solver. This one will integrate the equations taking into account the coupling 
between the compartment and the partition and solving the Neq,w+4 variables which are the pressure 
variation, the temperature in the upper zone, the temperature in the upper zone and the altitude of the zone 
interface, plus the temperatures at each node of the partitions. 

Using one dimension partition model in two zone model lead to artificially create or suppress some energy 
in the wall. Considering an increasing upper layer thickness (Figure A5), if the height separation between 
the zones is ZS at time t and ZS+∆ZS at time t+∆t, a wall of height ∆ZS is transformed from lower wall to 
upper wall. As the temperature of lower wall are generally lower than the ones of upper wall, some energy 
is created. On the contrary if the upper layer thickness is decreasing, some energy is lost. The only way to 
be rigorous when modelling walls in 2ZM, is to make a single two-dimensional partition model which 
would take into account vertical fluxes. The variation of ZS has to be taken into account in the boundary 
condition of the two-dimensional elements. 

 

Fig. A5 Upper, lower wall in the two zone model 

Boundary conditions 

For all type of partitions, the energy transmitted at the interface between the outside world and the partition 
is due to heat transfer by convection and radiation and is given by equation (A.27). 

 ( ) ( )4
1

4
1 ++ −+−= wNoutwNoutpout TTTThq εσ&  (A.27) 

The upper layer is composed of a mixture of combustion products and fresh air entrained by the plume from 
the lower layer. It is considered to be opaque and radiation between partitions connected to it are neglected. 
The energy transmitted between the inside surfaces of upper partition and the upper layer results from heat 
transfer by convection and radiation. 
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 ( ) ( )4
1

4
1, wUwUUwall TTTThq −+−= εσ&  (A.28) 

The lower layer is composed essentially of fresh air with only few combustion products, so its relative 
emissivity is considered to be nil. The energy transmitted between the inside surfaces of lower partitions 
and the lower layer results only from heat transfer by convection. The radiation from the fire is represented 
by the qfi,w term. 

 ( ) wfiwLLwall qTThq ,1, +−=&  (A.29) 

qfi,w [W/m²] is obtained by dividing 30% of the rate of heat release by the total area of the lower partition, 
including the opening area. 

One zone model 

When considering a one zone model during a whole simulation, a vertical partition is divided two parts 
connected to the single zone (Figure A6). The finite element mesh of the two parts and the boundary 
conditions are identical. Therefore, the temperatures distribution in the partitions and the flux densities on 
the bounders are the same in the two parts. Indeed, in a one zone model a vertical wall would normally not 
be divided into two. The results obtained with two partition models for a single wall are identical then those 
which would be obtained with only one partition model for the same single wall. The consequence of this 
procedure is only to increase the number of equation to be solved and therefor the computing time. Anyway, 
this have been done in order to enable the combination of 2ZM and 1ZM. 

 

Fig. A6 One zone model 

In one zone model, the system of equations (A.24) has to be build one time for the ceiling and one time for 
the floor. If the enclosure has M different types of walls, it has to be build 2M times If Neq,c and Neq,f the 
number of node of the ceiling and of the floor, and Neq,i the number of node of the wall n°i, the total set of 
partition equations contains Neq,w differential equations, also given by equation (A.26). 

Equations (A.15), (A.16) and equations (A.24) build Neq,w times form a set of Neq,w+2 differential equations 
which can be passed on to the numerical solver. This one will integrate the equations taking into account 
the coupling between the compartment and the partitions and will solve the Neq,w+2 variables which are the 
pressure variation and the temperature in the compartment, plus the temperatures at every node of the 
partitions. 

For 1ZM, if one considers that the usual procedure sets the limits of the compartment on the inside surface 
of the wall and adds a wall sub-model on top of it, the proposed procedure amounts in fact to set the limit 
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of the compartment on the outside surface of the wall. Because all the equations are solved simultaneously 
with an implicit procedure, the energy balance between the gas and the wall is totally respected. 

Boundary conditions 

For the three types of partitions, the energy transmitted at the interface between the outside world and the 
partition is due to heat transfer by convection and radiation and is given by equation (A.30). 

 ( ) ( )4
1

4
1 ++ −+−= wNoutwNoutpout TTTThq εσ&  (A.30) 

The energy transmitted at the inside partition interfaces results from heat transfer by convection and 
radiation between the zone and the partitions. 

 ( ) ( )4
1

4
1 wgwgwall TTTThq −+−= εσ&  (A.31) 

A.5 Switch from two zones to one zone model 

If some criteria are encountered during a two zone simulation, the code will automatically switch to a one 
zone simulation, which suits better to the situation inside the compartment at this moment. The simulation 
will continue to the end of the fire considering a one zone model. The criteria of switch will be explained 
in Annex F. The aim of this paragraph is to set how OZone deals with the basic variables of the zone 
models, how it sets the one zone initial conditions and how it deals with partitions models. 

Zone models formulation 

The time at which the switch from the 2ZM to the 1ZM happens is ts. The values of the eleven basic 
variables describing the gas in the two zones are known until ts thanks to the time integration of equations 
(A.8) to (A.11) and considering the constraints (A.1). To continue the simulation with a one zone model, 
it is possible to begin to solve the equations (A.15) and (A.16) associated to initial conditions representing 
the situation at that time. The point is to set the 1ZM initial values (at time ts). 

In one zone model, there are six variables describing the gas in the compartment as a whole, linked by four 
constraints. Two new constraints are needed to fix the new initial conditions. 

One obtains these two additional condition by setting that during the transition from 2 zones to 1 zone, the 
total mass of gas and the total energy in the compartment are conserved. 

 ( ) ( ) ( )sLsUsg tmtmtm +=  (A.32) 

 ( ) ( ) ( )sLsUsg tEtEtE +=  (A.33) 

The initial (at time ts) one zone temperature Tg(ts) and one zone pressure p(ts) can be deduce from equations 
(A.32), (A.33) and (A.12). 

Afterward, the one zone model runs with its associated sub-models for calculating exchanges of energy and 
mass through the vents. The partition models formulation and their initial values are explained in Annex F. 

Wall model formulation 

The partition temperatures at time ts are obtained by integrating the set of equations (A.24) coupled to the 
2 zone basic equations (A.8) to (A.11). At this time, the height of the lower and upper walls (vertical 
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partitions) are respectively ZS(ts) and H-ZS(ts). From the time of transition ts to the end of the calculation 
the one zone model is linked to the lower and upper walls which keep the dimension they had at time ts, i.e. 
Zs(ts) and H-ZS(ts). During the transition, no modification of partition temperatures of wall dimension is 
made, only the boundary conditions are modified. This way to proceed enables to fully respect the 
conservation of energy during the transition from the two zones to the one zone model. 

If a one zone model simulation is set from the beginning of the calculation, the dimension of the lower and 
upper walls are the initial dimensions, deduced from the initial altitude of separation of zones, until the end 
of the calculations. 

It means that during a one zone simulation (one zone as well as combination strategy) a wall is represented 
by two identical partitions which see the same boundary conditions at each time. 

 

Figure A7 Switch from two zone model to one zone model 

With a two zone model, lower walls are heated directly by radiation from the fire, and they give back energy 
to the lower layer by convection. If the switch encountered, they exchange energy by radiation and 
convection with the single zone. 
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ANNEX  B - EXCHANGE  THROUGH  VENTS 

Three types of vent models have been introduced in OZone: vertical vents, horizontal vents and forced vents. 

B.1 Vertical vents (in walls) 

B.1.1 Convective exchanges 

The mass flow through vents is calculated by integrating the Bernoulli’s law on each openings. 

 2

2
1

vp ρ=∆  (B.1) 
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with: subscript A: variable at origin of the flux; 

 subscript B: variable at destination of the flux; 

 Z' and Z": bounds of integration on altitude Z; 

 b: width of vertical vent; 

 α:  U if the integration is made in the upper layer, L if the integration is made in the lower layer and g in 
case of one zone model; 

 β: in if gas goes into the compartment, out if gas goes out of the compartment  

If the altitude where the pressure inside the compartment is equal to the pressure outside of the compartment is in a 
vertical vent, the vertical vents is divided in two parts, one where the mass flow goes inside the compartment and 
another one where the mass flow goes outside. This altitude is called the neutral plane altitude. Moreover in a two 
zone model, if the altitude of separation between the zones is in the opening, another subdivision in two encountered. 
In 1ZM (One Zone Model), three possibilities exist following the neutral level position. In 2ZM (Two Zones Model), 
10 possibilities exist following the neutral level and the zone separation altitude positions. For each vertical vent, 
equation A1 is the solved 1 or 3 times with the appropriate bounds of integration on the altitude (Z' and Z" can be 
the sill of the vent, the soffit of the vent, the neutral plane altitude or the separation between the zone altitude). 
Figure B1 shows in case of 2ZM and 1ZM one possible situation of relative position of Zsill, ZP, ZS and Zsoffit.   
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Fig. B1 Exchanges through vertical vents in (a) 2ZM and (b) 1ZM 

B.1.2 Radiative exchanges  

The radiation through the windows is taken into account by the Stefan-Boltzmann law. One consider that the 
radiation exists only bellow the altitude where the pressure inside the compartment is equal to the pressure outside 
the compartment. Above this level the gases goes out of the compartment and the temperature outside (in the plume) 
is assumed to be equal to the temperature in the compartment and thus it is considered that the net radiation flux is 
equal to zero (Figure B2). 

If the windows is closed no mass exchange exists through it. The glazing can be assumed adiabatic and no radiation 
through it is considered. If radiation is considered through the glazing, it is evaluated by the Stephan-Boltzmann 
law: 

 ( )44*
, outZglradgl TTq −= σε&  (B.2) 

in which *
glε  is a parameter which include the relative emissivities of the gazes and include also the part of energy 

which is reflected on the interfaces between gas and glass and absorbed by the glazing material; this parameter is 
highly dependent on the nature of the glazing material.  
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Fig. B2 Radiative exchanges through closed vertical vents in (a) 2ZM and (b) 1ZM 

B.2 Horizontal vents (in the ceiling)  

Gas flow through a horizontal ceiling vent is not always driven by the single pressure difference, buoyancy can also 
have a significant effect. These forces may lead to bidirectional exchange flow through the vent. Therefore it is not 
appropriate to unconditionally use Bernoulli's equation to model flow through horizontal vent.   

Cooper has established a model for calculating flows through circular, shallow (i.e. small depth to diameter ratio) 
horizontal vents. This model calculated the flow considering the pressure driven forces and when appropriated the 
combined pressure and buoyancy effects. The Cooper model is described in [COOPER 96], [COOPER 97]. 

B.3 Forced vents (smoke extractors)  

Forced vent model is built to represent the effect of mechanical ventilation. The forced vents are defined by the 
volume rate flow that they induced, VFV , their height ZFV and their diameter DFV  

When the zone interface is above the forced vent elevation + 1.5 DFV, the exhausted gas is lower-layer air only. 
When the zone interface is below the forced vent elevation - 1.5 DFV, the exhausted gas is upper-layer air only. When 
the zone interface is between ZS + 1.5 DFV and ZS - 1.5 DFV, the mass of extracted air from each layer is proportional 
to the distance between ZS and ZFV and 3DFV (Figure B3), 

If the forced vent is in the ceiling (Figure B4) an interpolation is made. When the zone interface is above the forced 
vent elevation - DFV, the exhausted gas is lower-layer air only. When the zone interface is below the forced vent 
elevation - 2 DFV, the exhausted gas is upper-layer air only. When the zone interface is between ZS-DFV and ZS-2DFV, 
the mass of extracted air from each layer is proportional to the distance between ZS and ZFV-DFV and 2DFV.   
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Fig.B3 Forced vent in the wall     Fig. B4 Forced vent in the ceiling 
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ANNEX  C - COMBUSTION  MODELS 

C.1 No combustion model  

The pyrolysis rate and the rate of heat release set in the data are considered in the mass and energy balances. No 
control by the ventilation will be used. At each time, the following equations will be satisfied:  

 ( ) ( )tmtm dataff ,&& =  (C.1) 

 ( ) ( )tRHRtRHR data=  

This case corresponds to the simulation of tests where the mass loss and the rate of heat release have been measured. 
It suits also to situations where the pyrolysis rate is known and where the fire is assumed to be fuel controlled.  

 

Fig. C1 Rate of Heat Release Curve   Fig. C2 Pyrolysis rate Curve 

C.2 External flaming Combustion model  

In this model the external combustion is assumed and all the fire load is transformed into gases in the compartment, 
but only a part of it delivers energy in the compartment. The rate of heat released by the fire may be limited by the 
quantity of oxygen available in the compartment, while the pyrolysis rate remains unchanged.   

When the mass of oxygen in the compartment is higher than 0kg, the fire is fuel controlled and all the mass loss of 
fuel delivers energy into the compartment:  

 ( ) ( )tmtm dataff ,&& =  (C.2) 

 ( ) ( ) ( ) effffdata HtmtRHRtRHR ,&==  

If all the oxygen in the compartment is consumed, the fire is ventilation controlled and the combustion is not 
complete. The energy released is governed by the mass of oxygen coming in the compartment through vents:  

 ( ) ( )tmtm dataff ,&& =  (C.3) 

 ( ) ( )
efff

inox H
tm

tRHR ,
,

27.1

&
=  

When oxygen is again available in the compartment, the fire is coming back to fuel controlled regime and equation 
C4 governs the pyrolysis and the heat release rates.  
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=  (C.4) 

 

Fig. C3 Oxygen mass curve 

 

Fig. C4 Rate of Heat Release Curve  Fig. C5 Pyrolysis Rate Curve 

C.3 Extended fire duration combustion model  

This model supposes that the release of mass may be limited by the quantity of oxygen available in the compartment. 
The total mass of fuel is burnt inside the compartment (safe procedure) then the fire duration is increased compared 
to the input one.  

When the mass of oxygen in the compartment is higher than 0kg, the fire is fuel controlled and all the mass loss of 
fuel delivers energy into the compartment: 

 ( ) ( )tmtm dataff ,&& =  (C.5) 

 ( ) ( ) ( ) effffdata HtmtRHRtRHR ,&==  

If the mass of oxygen in the compartment is 0kg, the fire is ventilation controlled. In this case, the mass lost by the 
fire is governed by the mass of oxygen coming in the compartment and all the pyrolised mass is transformed into 
energy:  

 ( ) ( )
27.1
, tm

tm inox
f

&
& =  (C.6) 
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The linear decreasing phase begins when 70% of the total fire load is consumed.  

In this model no external combustion is assumed, all the fire load delivers its energy into the compartment. If the 
fire is ventilation controlled, the pyrolysis rate is proportional to the oxygen coming in the compartment. This model 
is not a physical model because pyrolysis is not directly dependant on oxygen concentration. It has been established 
for design procedures, in order to avoid uncertainties on the maximum pyrolysis rate per unit floor area and therefor 
to be on the safe side concerning the fire duration.  

 

Fig. C6 Oxygen mass curve 

 

Fig. C7 Rate of heat release curve  Fig. C8 Pyrolysis rate curve 
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ANNEX  D - NATIONAL  ANNEXES AND NATIONAL  PARAMETERS  FOR THE  APPLICATION  OF THE  
NATURAL  FIRE  IN  DIFFERENT  EUROPEAN COUNTRIES IN  THE  OZONE SOFTWARE 

Several National Annexes of EN 1991-1-2 are introduced in OZone. By comparing the calculation method in 
application in a country to the original one described in the Eurocodes, three different options have been observed: 

- the values of the factors involved in the computation of the design fire load density as well as the calculation 
procedure were changed; 

- only the values involved in the computation of the design fire load density were changed; 
- no changes in the calculation procedure or for the values of the factors involved in the computation of the 

design fire load density. 

It should also be noted that Denmark do not allow using Annex E of EN1991-1-2 but no other calculation method is 
proposed in the Danish National Annex. This country is an exception. 

OZone interface is available in English and French and the occupancies have been translated into the National 
language(s) of the country. 

The German National Annex presents a specific method where two separate partial safety factors are calculated. The 
first one is applied to the fire load density (similar to EN) and the second one is applied to the Rate of Heat Release 
(not considered in the EN). These factors are function of the probability of occurrence of a damaging fire and the 
permitted probability of failure. A probabilistic equation is used to evaluate these two factors. 

In the Netherlands, the method is quite similar to the German one. However, it should be noted that the two partial 
safety factors applied to the fire load density and the Rate of Heat Release are identical. 

In UK, some formulae slightly differ but the method is the same as the Eurocode one. 

A large number of countries follow the same calculation method as the one described in the EN 1991-1-2 but the 
values of several parameters are different. For example: 

- Germany and France are using a 90% fractile (instead of 80%), fire load densities are consequently different; 
- Some countries have chosen to consider different fire load densities for several occupancies (independent of 

the choice of fractile); 
- France and Portugal have chosen to put all the delta factors accounting for active measures as equal to 1; 
- Belgium, Spain and Italy are using other values for delta factors accounting for active measures. 

A large number of countries have chosen to follow the Eurocode method without any modification of the values of 
factors influencing the fire load density, like Czech Republic, Estonia, Hungary, Luxembourg, Poland, Romania, 
Slovakia and Slovenia.  

In the following the national parameters for the application of the Natural Fire in different European countries are 
given. 

Belgium 

No changes in the calculation procedure were provided in the Belgium National Annex of EN1991-1-2. 

For Table D1, the values for the factors taking into account the fire activation risk due to the size of the compartment 
are replaced by a formula for areas between 25-2500m2. The descriptions of the occupancies are also extended. 

In Table D2, some factors taking into account the different active firefighting measures are modified. 

In Table D3, the hotel and hospital rooms are considered with the same fire load density and some supplementary 
provisions are considered in case of localised fires. 



LOCAFI+ – Temperature assessment of a vertical steel member subjected to LOCAlised Fire – Dissemination      Page 54 
 

RFCS-2016“LOCAFI+”-Grant Agreement 754072   

The values to be implemented for the Belgium National Annex in Ozone software are presented below. The 
modifications to the provisions of EN1991-1-2 are highlighted. 

Table D1 : Factors taking into account the fire activation risk due to the size of the compartment and type of 
occupancy (Belgium) 

Compartment 
floor area Af 

[m²] 

Danger of fire activation - 
Factor 1 

Danger of fire activation - 
Factor 2 

Examples of occupancies 

25 

δ q 1 = 1,1 + 0,4 log10 
(Af / 25) 

0.78 Galerie d’art, musée, piscine 

250 1 

Bureaux, résidence, hôtel, 
industries traitant des matières peu 
inflammables (produits en béton, 

en acier, industrie papetière), 
hôpitaux, écoles, commerces, 
salles de restaurant, espaces 

publics, parkings 

2500 1.22 

Fabrique de machines et de 
moteurs, industries traitant des 
matières inflammables(scierie, 
menuiserie, textile) , cuisines 

collectives 

5000 2 1.44 
Laboratoire de chimie, atelier de 

peinture 

10000 2.13 1.66 
Fabrique d’artifices ou de 

peintures 

Table D2 : Factors taking into account the different active measures (Belgium) 

Factor 1 Automatic Water Extinguishing System 0.61 or 0.78(industrial) 

Factor 2 Independent Water Supplies 0/1/2 1.0/0.95/0.91 

Factor 3 / 4 Automatic Fire Detection & Alarm (by Heat/ by Smoke) 0.87 or 0.73 

Factor 5 Automatic Alarm Transmission to Fire Brigade 0.87 

Factor 6 / 7 Work Fire Brigade / Off Site Fire Brigade 0.78 or 1 

Factor 8 Safe Access Routes 1 or 1.5 

Factor 9 Fire Fighting Devices 1 or 1.5 

Factor 10 Smoke Exhaust System 1 or 1.5 

Table D3 : Fire load densities, fire growth rate and RHRf for different occupancies (Belgium) 

Occupancy 
Fire Load 

80% fractile 
Fire Growth Rate RHRf* 

Logement 948 Medium 250 

Chambre d’hôtel ou d’hôpital 377 Medium 250 

Bibliothèque 1824 Fast 500 

Bureau 511 Medium 250 

Classe d’école 347 Medium 250 

Centre commercial 730 Fast 250 

Théâtre (cinéma) 365 Fast 500 

Transport de personnes (espace public) 122 Slow 250 

* “pour les feux localisés, on considère RHRf = 500kW/m² au minimum pour tous les types d’occupation” 
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Czech Republic 

No changes in the calculation procedure or for the values of the factors involved in the computation of the design fire 
load density were provided in the Czech Republic National Annex of EN1991-1-2. The values to be implemented 
for the Czech National Annex in Ozone software are the ones from EN1991-1-2. 

Croatia 

No changes in the calculation procedure or for the values of the factors involved in the computation of the design fire 
load density were provided in the Croatian National Annex of EN1991-1-2. The values to be implemented for 
Croatian National Annex in Ozone software are the ones from EN1991-1-2. 

Estonia 

No changes in the calculation procedure or for the values of the factors involved in the computation of the design fire 
load density were provided in the Estonian National Annex of EN1991-1-2. The values to be implemented for the 
Estonian National Annex in Ozone software are the ones from EN1991-1-2. 

France 

No changes in the calculation procedure were provided in the French National Annex of EN1991-1-2, but the values 
of the factors involved in the computation of the design fire load density are changed. 

In fact, all the values for the factors taking into account the fire activation risk due to the size of the compartment and 
the fire activation risk due to the type of occupancy, as well as the values for the factors taking into account the 
different active firefighting measures, are considered unitary. This means that, no reduction or increase of the 
characteristic fire load density is considered. 

However, the French National Annex of EN1991-1-2 states that the fire load density may be corrected to take into 
account the particular measures of prevention and protection against fire, for the specific case considered. In such 
case, it must be demonstrated that the final value considered does not increase the probability of collapse, compared 
to the normal situation.  

The values to be implemented for the French National Annex in Ozone software are presented below. The 
modifications to the provisions of EN1991-1-2 are highlighted. 

Table D4 : Factors taking into account the fire activation risk due to the size of the compartment and type of 
occupancy (France) 

Compartment floor area 
Af [m²] 

Danger of fire activation - 
Factor 1 

Danger of fire 
activation - 

Factor 2 
Examples of occupancies 

25 1 1 
artgallery, museum, swimming 

pool 

250 1 1 
offices,  residences, hotel, paper 

industry 

2500 1 1 
manufactory for machinerys and 

engines 

5000 1 1 
chemical laboratory, painting 

workshop 

10000 1 1 
manufactury of fireworks and 

paints 

 

Table D5 : Factors taking into account the different active measures (France) 
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Factor 1 Automatic Water Extinguishing System 1 
Factor 2 Independent Water Supplies 0/1/2 1 

Factor 3 / 4 Automatic Fire Detection & Alarm (by Heat/ by Smoke) 1 
Factor 5 Automatic Alarm Transmission to Fire Brigade 1 

Factor 6 / 7 Work Fire Brigade / Off Site Fire Brigade 1 
Factor 8 Safe Access Routes 1 
Factor 9 Fire Fighting Devices 1 
Factor 10 Smoke Exhaust System 1 

Table D6 : Fire load densities, fire growth rate and RHRf for different occupancies (France) 

Occupancy 
Fire Load 90% 

fractile 
Fire Growth Rate RHRf 

Logement 930 Medium 250 

Hopital 630 Medium 250 

Hotel (chambre) 460 Medium 250 

Bureau 740 Fast 250 

Bibliotheque de bureau - Archives de bureau 
(stockage 3m) 

2300 Rapide 500 

Salle de reunion 410 Medium 250 

Classe d'ecole 530 Moyen 250 

Centre commercial 840 Fast 500 

Theatre 420 Rapide 500 

Transport (espace public) 140 Slow 250 

Germany 

The calculation procedure provided in the German National Annex of EN1991-1-2 is different from the EN approach. 
EC and DIN EN have the same probabilistic approach, but the parameters resulting from their research works are 
different.  

The risk of fire activation in DIN EN is given by: 

Pfi = P1 x P2 x P3 x Afi 

in which: 

P1 : probability of severe fire not stopped by occupants according to the building category 

P2 : reduction factor depending on the fire brigade type and on the time between alarm and firemen intervention 

P3 : reduction factor if automatic fire detection (by smoke or heat), automatic transmission of the alarm, sprinkler 
systems are present 

The safety factor in EN (applied to the fire load density) is calculated as product of the delta factors, while in the 
German Annex the safety factors (two different factors applied to RHR and fire load density) have to be explicitly 
calculated from the probabilistic formula: 
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Also, Table D7, containing the values of the fire load densities for different occupancies is modified. The values to 
be implemented for the German National Annex in Ozone software are presented below. The modifications to the 
provisions of EN1991-1-2 are highlighted. 

Table D7 : Fire load densities, fire growth rate and RHRf for different occupancies (Germany) 

Occupancy 
Fire Load 90% 

fractile 
Fire Growth Rate RHRf 

Wohngebäude 1085 mittel 250 

Burogebäude 584 mittel 250 

Krankenhauss (Zimmer) 320 mittel 250 

Hotel (Zimmer) 431 mittel 250 

Bibliothek 2087 mittel 250 to 500 

Schule 397 mittel 150 

Verkaufsstätte 835 schnell 250 

Theater, Kino 417 schnell 500 

Transport (public space) 139 langsam 250 

The practical procedure in the Ozone software involves first the definition of the geometry of the compartment 
(dimensions, nature of partitions, openings, smoke evacuator systems …) in the common module of OZone. The 
difference from the other procedures is that, upon selecting “Germany” from the list of National Annexes, in the open 
window the appropriate input values must be defined. 

 

Fig. D1 : General parameters for application of the German National Annex 

In the main “Fire Definition” window, the Fire Growth rate, the RHRf and the qfk are automatically computed. Also, 
by selecting the DIN EN, all three factors that multiply qfk from EN are automatically set to 1.0 in Ozone. 
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Fig. D2 : Specific parameters of the German National Annex 

Afterwards, the calculation with Ozone performs as usual in order to obtain the temperature curve for design purpose. 

Hungary 

No changes in the calculation procedure or for the values of the factors involved in the computation of the design fire 
load density were provided in the Hungarian National Annex of EN1991-1-2. The values to be implemented for the 
Hungarian National Annex in Ozone software are the ones from EN1991-1-2. 

Italy 

Some changes in the calculation procedure, as well as for the values of different factors involved in the computation 
of the design fire load density were provided in the Italian National Annex of EN1991-1-2. The values to be 
implemented for theItalian National Annex in Ozone software are presented below. The modifications to the 
provisions of EN1991-1-2 are highlighted. 

Table D8 : Factors taking into account the fire activation risk due to the size of the compartment and type of 
occupancy (Italy) 

Compartment floor area Af [m²] Danger of fire activation - Factor 1 
25 1 

250 1 

500 1.2 

1000 1.4 

2500 1.6 

5000 1.8 

10000 2 

The second factor for danger activation is computed according to the following: 

0.8 Areas that have a low fire risk in terms of ignition probability, flame propagation speed and possibility of 
fire control from the fire brigades 
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1.0 Areas that have a medium fire risk in terms of ignition probability, flame propagation speed and possibility 
of fire control from the fire brigades 

1.2 Areas that have a high fire risk in terms of ignition probability, flame propagation speed and possibility of 
fire control from the fire brigades 

Table D9 : Factors taking into account the different active measures (Italy) 

Factor 1 Automatic Water Extinguishing System 1/0.6 

Factor 2 Independent Water Supplies 0/1/2 1/1/1 

Factor 3 / 4 Automatic Fire Detection & Alarm (by Heat/ by Smoke) 1/0.85/0.85 

Factor 5 Automatic Alarm Transmission to Fire Brigade 1/1 

Factor 6 / 7 Work Fire Brigade / Off Site Fire Brigade 1/0.9/1 

Factor 8 Safe Access Routes 1/0.9/0.9 

Factor 9 Fire Fighting Devices 1/0.9/0.8 

Factor 10 Smoke Exhaust System 1/1 

Luxembourg 

No changes in the calculation procedure or for the values of the factors involved in the computation of the design fire 
load density were provided in the Luxembourg National Annex of EN1991-1-2. The values to be implemented for 
the Luxembourgish National Annex in Ozone software are the ones from EN1991-1-2. 

The Netherlands  

Changes in the calculation procedure were provided in the Dutch National Annex of EN1991-1-2. Instead of applying 
directly the delta coefficients to the characteristic fire load density, in the Dutch NA a global risk factor is calculated. 
The risk factor, which should be calculated by the user, is dependent on the compartment size, occupation and active 
measures considered. This factor is applied to the RHR curve, not to the characteristic fire load density. Depending 
on the fire resistance requirement, the fire load is additionally multiplied with a supplementary coefficient, which is 
0,5 for 30 minutes; 1,0 for 60; 1,5 for 90; 2,0 for 120. 

Table D10, containing the values of the fire load densities for different occupancies, is modified. The values to be 
implemented for the Dutch National Annex in Ozone software are presented below. The modifications to the 
provisions of EN1991-1-2 are highlighted. 

Table D10 : Fire load densities, fire growth rate and RHRf for different occupancies (The Netherlands) 

Occupancy Fire Load 80% fractile Fire Growth Rate RHRf 
Dwelling 870 Medium 250 

Hospital 350 Medium 250 

Hotel (room) 400 Medium 250 

Library 1824 Fast 500 

Office (standard) 570 Medium 250 

School 360 Medium 250 

Shopping Centre 730 Fast 250 

Theatre (movie/cinema) 365 Fast 500 

Transport (public space) 122 Slow 250 

Portugal 
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No changes in the calculation procedure were provided in the Portuguese National Annex of EN1991-1-2, but, as in 
the case of the French National Annex, the values of the factors involved in the computation of the design fire load 
density are considered unitary. 

The values to be implemented for the Portuguese National Annex in Ozone software are presented below. The 
modifications to the provisions of EN1991-1-2 are highlighted. 

Table D11 : Factors taking into account the fire activation risk due to the size of the compartment and type of 
occupancy (Portugal) 

Compartment floor 
area Af [m²] 

Danger of fire activation - 
Factor 1 

Danger of fire 
activation - 

Factor 2 
Examples of occupancies 

25 1 1 artgallery, museum, swimming pool 

250 1 1 
offices,  residences, hotel, paper 

industry 

2500 1 1 
manufactory for machinerys and 

engines 

5000 1 1 
chemical laboratory, painting 

workshop 
10000 1 1 manufactury of fireworks and paints 

Table D12 : Factors taking into account the different active measures (Portugal) 

Factor 1 Automatic Water Extinguishing System 1 

Factor 2 Independent Water Supplies 0/1/2 1 

Factor 3 / 4 Automatic Fire Detection & Alarm (by Heat/ by Smoke) 1 

Factor 5 Automatic Alarm Transmission to Fire Brigade 1 

Factor 6 / 7 Work Fire Brigade / Off Site Fire Brigade 1 

Factor 8 Safe Access Routes 1 

Factor 9 Fire Fighting Devices 1 

Factor 10 Smoke Exhaust System 1 

Romania 

No changes in the calculation procedure or for the values of the factors involved in the computation of the design fire 
load density were provided in the Romanian National Annex of EN1991-1-2. The values to be implemented for the 
Romanian National Annex in Ozone software are the ones from EN1991-1-2. 

Spain 

No changes in the calculation procedure were provided in the Spanish National Annex of EN1991-1-2. 

For Table D13, the descriptions of the occupancies are extended and different values are provided for the danger of 
fire activation coefficient. 

In Table D14, only the factors accounting for Automatic Water Extinguishing System, Automatic Fire Detection & 
Alarm (by Heat/ by Smoke) and for Automatic Alarm Transmission to Fire Brigade are considered. 

In Table D15, some fire load densities are modified. 

The values to be implemented for the Spanish National Annex in Ozone software are presented below. The 
modifications to the provisions of EN1991-1-2 are highlighted. 
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Table D13 : Factors taking into account the fire activation risk due to the size of the compartment and type of 
occupancy (Spain) 

Compartment floor 
area Af [m²] 

Danger of fire 
activation - Factor 1 

Danger of fire 
activation - Factor 2 

Examples of occupancies 

25 1.1 0.78 Galería de arte, museo, piscina 

250 1.5 1.25 
Vivienda, administrativo, 

residencial, docente 
2500 1.9 1.25 Sectores de riesgo especial bajo 

5000 2 1.4 Sectores de riesgo especial medio 

10000 2.13 1.6 Sectores de riesgo especial alto 

Table D14 : Factors taking into account the different active measures (Spain) 

Factor 1 Automatic Water Extinguishing System 0.61 

Factor 2 Independent Water Supplies 0/1/2 1 

Factor 3 / 4 Automatic Fire Detection & Alarm (by Heat/ by Smoke) 0.87 

Factor 5 Automatic Alarm Transmission to Fire Brigade 0.87 

Factor 6 / 7 Work Fire Brigade / Off Site Fire Brigade 1 

Factor 8 Safe Access Routes 1 

Factor 9 Fire Fighting Devices 1 

Factor 10 Smoke Exhaust System 1 

Table D15 : Fire load densities, fire growth rate and RHRf for different occupancies (Spain) 

Occupancy 
Fire Load 80% 

fractile 
Fire Growth Rate RHRf 

Vivienda 650 Medio 250 

Hospital (habitación) 280 Medio 250 

Hotel (habitación) 280 Medio 250 

Biblioteca 1824 Rápido 500 

Oficina 520 Medio 250 

Aula de escuela 350 Medio 250 

Centro comercial 730 Rápido 250 

Teatro (cine) 365 Rápido 500 

Transporte (espacio público) 122 Lento 250 

Slovenia 

No changes in the calculation procedure or for the values of the factors involved in the computation of the design fire 
load density were provided in Slovenian National Annex of EN1991-1-2. The values to be implemented for the 
Slovenian National Annex in Ozone software are the ones from EN1991-1-2. 

Sweden 

No changes in the calculation procedure were provided in the Swedish National Annex of EN1991-1-2. All the values 
for the factors taking into account the fire activation risk due to the size of the compartment and the fire activation 
risk due to the type of occupancy, as well as the values for the factors taking into account the different active 
firefighting measures, are considered unitary. This means that, no reduction or increase of the characteristic fire load 
density is considered. 
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The values to be implemented for the Swedish National Annex in Ozone software are presented below. The 
modifications to the provisions of EN1991-1-2 are highlighted. 

Table D16 : Factors taking into account the fire activation risk due to the size of the compartment and type of 
occupancy (Sweden) 

Compartment floor area 
Af [m²] 

Danger of fire activation - 
Factor 1 

Danger of fire 
activation - 

Factor 2 
Examples of occupancies 

25 1 1 
artgallery, museum, swimming 

pool 

250 1 1 
offices,  residences, hotel, paper 

industry 

2500 1 1 
manufactory for machinerys and 

engines 

5000 1 1 
chemical laboratory, painting 

workshop 

10000 1 1 
manufactury of fireworks and 

paints 

Table D17 : Factors taking into account the different active measures (Sweden) 

Factor 1 Automatic Water Extinguishing System 1 
Factor 2 Independent Water Supplies 0/1/2 1 

Factor 3 / 4 Automatic Fire Detection & Alarm (by Heat/ by Smoke) 1 
Factor 5 Automatic Alarm Transmission to Fire Brigade 1 

Factor 6 / 7 Work Fire Brigade / Off Site Fire Brigade 1 
Factor 8 Safe Access Routes 1 
Factor 9 Fire Fighting Devices 1 
Factor 10 Smoke Exhaust System 1 

Table D18 : Fire load densities, fire growth rate and RHRf for different occupancies (Sweden) 

Occupancy Fire Load 80% fractile Fire Growth Rate RHRf 
Dwelling 750 Medium 250 

Hospital 360 Medium 250 

Hotel (room) 400 Medium 250 

Library 1800 Fast 500 

Office (standard) 520 Medium 250 

School 450 Medium 250 

Shopping Centre 400 Fast 250 

Theatre (movie/cinema) 370 Fast 500 

Transport (public space) 122 Slow 250 

United Kingdom 

The calculation procedure provided in the PD 6688-1-2 is the same as the one of the EN1991-1-2. A different 
parameter “fire growth rate parameter” is introduced but this leads to results very close to those obtained by use of 
the EN1991-1-2. All the values for the factors taking into account the fire activation risk due to the size of the 
compartment and the fire activation risk due to the type of occupancy, as well as the values for the factors taking into 
account the different active firefighting measures are considered unitary, except for the presence of sprinklers.  

The values to be implemented for the UK National Annex (PD 6688-1-2) in Ozone software are presented below. 
The modifications to the provisions of EN1991-1-2 are highlighted. 
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Table D19 : Factors taking into account the fire activation risk due to the size of the compartment and type of 
occupancy (UK) 

Compartment floor area 
Af [m2] 

Danger of fire activation - 
Factor 1 

Danger of fire 
activation - 

Factor 2 
Examples of occupancies 

25 1 1 
artgallery, museum, swimming 

pool 

250 1 1 
offices,  residences, hotel, paper 

industry 

2500 1 1 
manufactory for machinerys and 

engines 

5000 1 1 
chemical laboratory, painting 

workshop 

10000 1 1 
manufactury of fireworks and 

paints 

Table D20 : Factors taking into account the different active measures (UK) 

Factor 1 Automatic Water Extinguishing System 0.61 

Factor 2 Independent Water Supplies 0/1/2 1 

Factor 3 / 4 Automatic Fire Detection & Alarm (by Heat/ by Smoke) 1 

Factor 5 Automatic Alarm Transmission to Fire Brigade 1 

Factor 6 / 7 Work Fire Brigade / Off Site Fire Brigade 1 

Factor 8 Safe Access Routes 1 

Factor 9 Fire Fighting Devices 1 

Factor 10 Smoke Exhaust System 1 

Table D21 : Fire load densities, fire growth rate and RHRf for different occupancies (UK) 

Occupancy Fire Load 80% fractile Fire Growth Rate RHRf 
Dwelling 870 Medium 250 

Hospital 350 Medium 250 

Hotel (room) 400 Medium 250 

Library 2250 Fast 500 

Office (standard) 570 Medium 250 

School 360 Medium 250 

Shopping Centre 900 Fast 250 

Theatre (movie/cinema) - - - 

Transport (public space) - - - 
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ANNEX  E - LOCALISED  FIRE  PROCEDURE 

The localised fire procedure implemented in OZone is based on the work made in the research project RFSR-CT-
2012-00023 LOCAFI - Temperature assessment of a vertical steel member subjected to LOCAlised Fire. The 
analytical model for localised fires has been developed within the project with two levels of refinement: 

- A model based on numerical integration for implementation into advanced models like SAFIR and Ansys - 
“geometric model”; 

- A model based on analytical formulae for handmade use or implementation into basic engineering tools like 
Excel spreadsheets - “simplified model”. 

In both geometric and simplified models, the configurations where the thermal exchanges are drawn by convective 
fluxes (member engulfed into the fire or situated inside the smoke layer) are treated by application of the existing 
equations available in the EN 1991-1-2. The major heat exchanges, by radiation, are calculated by representing the 
fire as a virtual solid flame that radiates in all the directions. The first step of this calculation is again common to the 
geometric and simplified models and consists in defining the geometry of the virtual solid flame representing the 
localised fire and the distribution of temperature as a function of time. 

The shape of the virtual solid flame representing the thermal action of the localised fire may be cylindrical or conical. 
The cylindrical shape flame is simpler to deal with but usually represents less accurately the thermal attack induced 
by the fire and leads to overestimated radiative heat fluxes. In case the flame length is higher than the ceiling level, 
the cylinder or the cone must be truncated and a radiant ring, representing the spreading of the flame under the ceiling, 
should be considered outside the truncated cylinder or cone. 

The difference between the geometric and simplified models is the calculation method used for the assessment of the 
radiative heat fluxes exchanged between the virtual solid flame and the elements. 

In order to propose a calculation method without surface integral (that generally requires the implementation into a 
solver), the simplified model implemented in OZone was defined on the basis of configuration factors. For simple 
shapes like cylinder or ring, direct formulae are available under several conditions. By means of slight adaptations 
of the virtual solid flame, these conditions are satisfied and the calculation of radiative heat fluxes can be calculated 
using the concept of configuration factor. 

The implementation of the simplified model in OZone software considers a conical shape for the virtual solid flame 
as it has been demonstrated that this shape is leading to the best flux predictions. The flux is calculated separately for 
the 4 faces of the box perimeter of the profile and an average value of this flux is applied to the whole perimeter of 
the steel section. This means that the shadow effect is not taken into account. The coupling between localised fire 
and compartment fire allows combining the influences of the radiative heat fluxes through the cold zone and of the 
convective fluxes in the hot zone. The input data of the “Localised fire” part requires defining the position, diameter 
and evolution of HRR with time for a maximum number of 5 fires. The calculation of steel temperatures under the 
calculated heat fluxes was already available previously and assumes that the temperature is uniform through the 
cross-section. 

More detailed information about the simplified model for localised fire implemented in OZone is given in the Final 
Report of the research project RFSR-CT-2012-00023 LOCAFI - Temperature assessment of a vertical steel member 
subjected to LOCAlised Fire. 
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ANNEX  F - ANALYSIS  STRATEGY  AND TRANSITION  CRITERIA 

If a fire is modelled by the plain curve of the Figure F1 the growing phase, represented here by a t² curve, is reaching 
a maximum at the time at which all the fuel has been ignited. If the fuel ignition happens only by flame spread, the 
maximum is reached without modification of the initial t² curve. If the temperatures of hot gases of the upper layer 
of a fire reach a sufficiently high temperature (about 500°C to 600°C), the radiative flux between the hot gas and 
the non-burning combustible materials can be as high as to ignite the fuel. At this moment there is a very fast 
increased of the energy release rate. This phenomenon is called flashover. This modification is made by modifying 
the initial heat release rate curve as indicated by the dotted line in Figure F1. At the flashover time, the RHR curve 
is left and goes to its maximum value equal to the maximum fire area multiplied by the heat release rate density 
RHRf.  

If the gases in contact with the fuel reach a temperature of about 300°C, the fuel also ignites and the rate of heat 
release increases as stated for the flashover phenomena.  

 

Fig. F1 Modification of RHR(t) in case of flashover 

The criteria of the transition from two to one zone and/or of modification of the fire source model are given in the 
following.  

Criterion 1 (C1): TU > TFL    

High temperature of the upper layer gases, composed of combustion products and entrained air, leads to a flashover. 
All the fuel in the compartment is ignited by radiative flux from the upper layer. The flashover temperature (TFL) is 
set to 500°C.   

Criterion 2 (C2): Zs < Zq and TZ > Tignition    

If the gases in contact with the fuel have a higher temperature than the ignition temperature of fuel (Tignition), the 
propagation of fire to all the combustible of the compartment will occur by convective ignition. The gases in contact 
(at temperature TZ) can either belong to the lower layer of a two zone, the upper layer (if the decrease of the interface 
height (ZS) leads to put combustible in the smoke layer - Zq is the maximum height of the combustible material) or 
the unique zone of one zone models. Tignition is assumed to be 300°C.  

Criterion 3 (C3): ZS < 0.2 H    
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The interface height goes down and leads to a very small lower layer thickness, which is not representative of two 
zone phenomenon.  

Criterion 4 (C4): Afi > 0.25 Af    

The fire area is too high compared to the floor surface of the compartment to consider that the fire remains confined.  

Criteria 1 or 2 lead necessarily to a modification of the rate of heat release. If the fire load remains localised (C4 is 
not fulfilled), the simulation will continue using a 2ZM and if the fire load is uniformly distributed, a 1ZM will be 
considered. If one of the criteria C3 or C4 is fulfilled, the code will switch to a one zone model but the RHR will 
not be modified, except if criterion C1 or C2 happens simultaneously. The Table F1 and Figures F2 and F3 
summarize the four criteria.  

Table F1 Transition criteria 

CRITERIA  EFFECT  
  LOCALISED q f  DISTRIBUTED q f  

C1 : TU > 500°C  Afi  = Afi,max  1ZM + Afi  = Afi,max  
C2 :  Zs < Hq and TU > Tignition (2ZM)     or, 
 Zs > Hq and TL > Tignition (2ZM)     or,
 T   > Tignition (1ZM)  

Afi  = Afi,max  1ZM + Afi  = Afi,max  

C3 :  Zs < H  1ZM  1ZM  
C4 :  Afi  > 0.25% Af  -  1ZM  

 If the fire load is confined, five different paths are possible:  

• PATH 1 - None criterion are encountered then the model will remain with two zones and the RHR curve will 
not be modified until the end of the fire.   

• PATH 2 - Criterion C1 or C2 is first encountered, leading to a RHR modification. Criterion C3 is not 
encountered, the model remains a two zones one.  

• PATH 3 - Criterion C1 or C2 is first encountered, leading to a RHR modification. Criterion C3 is encountered, 
the model switch from a two zones to a one zone.  

• PATH 4 - Criterion C3 is first encountered, the model switch from a two zones to a one zone. The criteria C1 
and C2 are not encountered, leading to no RHR modification.  

• PATH 5 - Criterion C3 is first encountered, the model switch from a two zones to a one zone. The criterion C1 
or C2 is then encountered, leading to a RHR modification.  

If the fire load is uniformly distributed, three different paths are possible:  

• PATH 6 - Criterion C1 or C2 is encountered, leading to a RHR modification and a simultaneous switch from a 
two zones to a one zone model.  

• PATH 7 - Criterion C3 or C4 is first encountered, the model switch from a two zones to a one zone. The criterion 
C1 and C2 are not encountered, leading to no RHR modification.  

• PATH 8 - Criterion C3 or C4 is first encountered, the model switch from a two zones to a one zone. Criterion 
C1 or C2 is then encountered, leading to a RHR modification.  
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Fig F2 Flow chart of the combination strategy 
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Fig. F3 Four criteria to switch from two zone to one zone model and/or modify the heat release rate 
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